& Wolters Kluwer

Release Notes

2016 Knowledge Based Audits™ of Single Audits for ProSystem fx® Knowledge Coach
November 2016

2016 Knowledge-Based Audits™ of Single Audits for ProSystem fx® Knowledge Coach

Welcome to 2016 Knowledge-Based Audits™ of Single Audits for ProSystem fx® Knowledge Coach

This Release Notes document provides important information about the 2016 release of Knowledge Based Audits ™ of Single Audits.
Please review this information carefully. If you have any questions, contact Customer Support at 1-800-PFX-9998. Additional
information is available on CCH Support Online.

New in this Release

Knowledge-Based Single Audits is a supplement to the financial statement audit methodologies provided in Knowledge-Based Audits of
Governmental Entities and Knowledge-Based Audits of Not-for-Profit Entities.

This single audit supplement is designed to help the auditor efficiently and effectively perform the compliance audit portion of the
single audit. The methodology has been developed to be compliant with auditing standards generally accepted in the United States of
America (U.S GAAS), Government Auditing Standards (GAGAS), and the audit requirements of 2CFR200, the Uniform Administrative
Requirements, Cost Principles, and Audit Requirements for Federal Awards, (the Uniform Guidance). The frequently asked questions
released by the Council on Financial Assistance Reform (COFAR) include information on transition provisions to the Uniform Guidance.
The Uniform Guidance contains administrative requirements and cost principles beginning December 26, 2014, for all new federal
awards and funding increments (additional funding to existing federal awards) with modified award terms and conditions that are
awarded on or after that date. Implementation of administrative and cost provisions began on December 26, 2014, and is staggered by
grant award. In most cases, the terms and conditions of the federal award should identify whether the funding increment is subject to
the Uniform Guidance requirements, or whether it will continue to be governed by the original terms and conditions of the federal
award (that is, subject to the pre-Uniform Guidance requirements). The effective date of the Uniform Guidance as it relates to a
subaward (pass-through grant to a subrecipient) is the same as the effective date of the federal award. The audit provisions of the
Uniform Guidance apply to audits of fiscal years beginning on or after December 26, 2014, and are fully implemented with the release
of this tool set. 2016 Knowledge-Based Single Audits only contains tools referencing the Uniform Guidance. For those few biennial
audits for periods that began before December 26, 2014, and would still be performed in accordance with the former Circular A-133,
the auditor should download the Tools issued prior to calendar year 2016.

The knowledge-based audit is a risk-based methodology that emphasizes using knowledge of the entity to assess and respond to risks
relevant to the audit. Compliance audits are often unique and complex and require specialized accounting and auditing knowledge. This
edition includes specific up-to-date guidance for conducting these compliance audits.

Conducting single audits requires the exercise of the auditor’s professional judgment.

This document is published for the purpose of communicating, to users of the toolset, updates and enhancements included in the
current version. This document is not, and should not be used as an audit program to update the audit documentation of an
engagement started in a previous version of this product.

This is the eighth update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the Knowledge
Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.

The 2016 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.

The 2016 edition of Knowledge-Based Single Audit features numerous enhancements, including:
¢ Allsteps, tailoring questions and practice points related to OMB Circulars relating to grants and funding before December 31,

2014 in AUD-802S, AUD-803S, AUD-804S, AUD-805S, AUD-808S, AUD-810S, AUD814S, AUD-815S and AUD-817S have been
removed.

o The steps, tailoring questions and practice points related to OMB Circulars relating to grants and funding before
December 31, 2014 in AUD-811S Audit Program: Procurement and Suspension and Debarment are not removed due


http://support.cch.com/productsupport/

to a two year grace period for the procurement rules under the Uniform Guidance. Even if the Uniform Guidance has
been completely adopted an entity could still use A-133 guidance in this area until June 30, 2017.

¢ A comments column has been added to KBA-502 Assertion Level Risk Table.

¢ Anew Not Applicable option has been added in KBA-103 column 15, "If Not a Material Weakness or Significant Deficiency, Is It
Important Enough to Merit Attention by Those Charged with Governance?"

¢ The diagnostic on the findings tables column “For Material Noncompliance Finding, Select Major Program” when the user hasn't
selected “Noncompliance” in the “Type of Finding” column will no longer show. This diagnostic will only show when the user
selects “Noncompliance” in the “Type of Finding” column. This change affects the following workpapers: AID-401S, AUD-701S,
AUD-901S, KBA-303S, and KBA-501S.

¢ Anew Not Applicable option has been added in AUD-602S to question 9, “If the component prepares financial statements using
a different financial reporting framework than that used by the group, we have evaluated following:”

¢ Anew flow of the major program or cluster name will flow into KBA-102S when the user has a finding noted as significant in any
AUD-80X series workpaper.

¢ There are many new and modified control objectives and modified practice points in the Understanding Compliance
Requirement-Level Controls workpapers KBA-402S through KBA-414S due to compliance with the Uniform Guidance. Make
sure you review KCO-00T.
¢ There are new CORs and RPTs including:
o COR-201CS Single Audit Engagement Letter: Governmental Entity (Uniform Guidance), Integrated Audit
o COR-202CS Single Audit Engagement Letter: Not-for-Profit Entity (Uniform Guidance), Integrated Audit

o RPT-913AS Report on Schedule of Expenditures of Federal Awards When the Auditor is Issuing a Stand-Alone Report
Under AU-C Section 805, Special Considerations: Audits of Single Financial Statements and Specific Elements,
Accounts, or Items of a Financial Statement

Click here for the 2016 Single Audit Title Overview for Knowledge Coach Users

In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take
into account:

New literature, standards, and developments, reflected in the following current audit and accounting guidance:
¢ SAS No. 131, Amendments to Statement on Auditing Standards No. 122 Section 700, "Forming an Opinion and Reporting on
Financial Statements" (AU-C Section 700)

¢ SAS No. 130, An Audit of Internal Control Over Financial Reporting That Is Integrated With an Audit of Financial Statements
(AU-C Section 940)

¢ Title 2 U.S. Code of Federal Regulations (CFR) Part 200, Uniform Administrative Requirements, Cost Principles, and Audit
Requirements for Federal Awards (Uniform Guidance)

2016 OMB Compliance Supplement;

Government Auditing Standards, December 2011 Revision (Yellow Book).

AICPA Code of Professional Conduct—Revised (Code)

AICPA Statement on Quality Control Standards No. 8, A Firm's System of Quality Control (Redrafted)

ET Section 1.295, Nonattest Services;

Committee of Sponsoring Organizations (COSO) 2013 update to Internal Control —Integrated Framework; and
2016 Data Collection form.
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¢ Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.
¢ If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:

o Keep the binder with the affected workpapers open.

o Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.


http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2016%20Single%20Audit%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf

¢ Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach
workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central file
room and through peer-to-peer sync in the same way other Engagement workpapers are shared.

System Requirements
¢ This title MUST be used with ProSystem fx ® Engagement version 7.5 or higher, ProSystem fx® Knowledge Coach version 2.5,
and 2016 Compliance Base or higher. If you have not installed the ProSystem fx® Engagement 7.5 and Knowledge 2.5, ensure

that you do so before using this title. If you are upgrading from ProSystem fx® Engagement 7.1 or lower please contact Technical
Support at 1-800-PFX-9998 for detailed instructions.

¢ A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Download Instructions

Download the 2016 Knowledge Based Single Audit from the ProSystem fx ®Knowledge Coach Updates section of the ProSystem fx®
Engagement Support Web site at the following URL: http://support.cch.com/updates/KnowledgeCoach, then select the Knowledge
Coach Series and Download file link next to the 2016 Knowledge-Based Single Audit. On some occasions the content package file (.KCP)
will download with the extension changed to .ZIP. If this occurs, please change the extension of the downloaded file to KCP using all
capital letters.

You must install the 2016 Compliance Base title before installing the 2016 Knowledge Based Single Audit.
The Compliance Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach

Important: ProSystem fx® Engagement version 7.5 or higher and Knowledge Coach version 2.5 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2010, Microsoft® Office 2010 Primary
Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).

The 2016 Knowledge-Based Single Audit (11/17/16). KCP download is a proprietary file that must be installed from within Engagement.
Save this KCP file to a location on your local drive and follow the Installation Instructions included in the Release Bulletin.

Installation Instructions

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.

After downloading the 2016 Knowledge Based Single Audit, do the following:

¢ Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

¢ The Knowledge Coach Titles window will be displayed.
¢ Choose Add Title.

¢ Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

¢ Choose Open.

¢ The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.

Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.

To release a title:

¢ Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
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¢ Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”
Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.
Important: Once the 2016 Knowledge-Based Single Audit title has been added and released, they will be automatically deployed to
other staff members when they login to the “Office” location, or when they synchronize a binder that contains Knowledge Coach
workpapers from this title.

Online Permission Key

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.5 and higher. After
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2016
Knowledge-Based Single Audit.

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.

Accounting Research Manager

CCH's Accounting Research Manager ("ARM") is the most comprehensive, up-to-date and objective online database of financial
reporting literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.

Available on ARM, the Knowledge-Based Single Audit Guide helps you comply with the most recent professional standards and
guidance for the conduct single audits and to integrate the use of practice aids, tools, and other resources with its guidance. This
publication supplements and complements the Knowledge-Based documents that are available in Knowledge Coach.

If you subscribe to an ARM library that includes Single Audit content, you can link directly to source material from Resources within
Knowledge Coach documents. These links have been updated to refer to the accounting standards under the FASB Accounting
Standards Codifications. Also, if you subscribe to the Knowledge-Based Single Audit Guide on ARM, you can take advantage of
references to the guide material from within the Knowledge Coach documents.

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the
Shortcuts bar in the Binder window.
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Using Your Knowledge Coach Content

To use your Knowledge Coach Workpaper Templates, open a
binder in ProSystem fx® Engagement, select the workpaper tab
into which you would like to insert the workpaper, and select
New Knowledge Coach Workpaper from the toolbar or File

MNew Knowledge Coach Workpaper *

Industry: 2016 KBA Single Audits | ¢ =2
[] Add Independent \Workpapers without Foundation Workpapers

menu. The New Knowledge Coach Workpaper dialog appears 511  000Resources Details of selected workpaper
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would like to use. You can only select titles you have installed. 5[] 500-Assessing Risk of Material Misstatemert Highlight a workpaper or select
H H i #-]  600-Audt Procedurss-Response to Assessed Risks a workpaper check box to see
The |n.forr.nat|on .dlsplayed changes to rgflect the workpaper T] 700 Ak Proosdures Teos o rtamel ool 3 vorlg
organization available for the selected title. Select the o0  800Audt Procedures Substartive Tests
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Knowledge Coach Workpaper Templates to insert into your
binder and click OK. The Selected Workpaper Properties dialog
appears. Each workpaper name is automatically loaded into the
Name field. Add a workpaper index in the Index field and make
any Name modifications you desire. You can also modify the
tab location or the roll forward settings for each workpaper.
Then click OK. The integrated Knowledge Coach workpaper is
now inserted into your engagement binder. For more
information on how to use Knowledge Coach workpapers in
your binder, see the Knowledge Coach User Guide.

Cancel Help

Figure 1 - New Knowledge Coach Workpaper

Additional Information on Knowledge Coach and the KBA Methodology

Knowledge-Based Audit (KBA) Methodology - Allows the results of one set of procedures to become the input for the next. The key
components of the KBA methodology include:

¢

An Overview that guides auditors through the methodology (for single audits, auditors can refer to the applicable Overview in
Knowledge-Based Audits of Governmental Entities or Knowledge-Based Audits of Not-for-Profit Entities);

Knowledge-Based Audit documents, integral to the risk assessment and overall audit processes, which contain steps and
procedures required by GAAS, GAGAS, the OMB Compliance Supplement and the Uniform Guidance;

Customizable Audit Programs that take auditors through related steps and procedures of the compliance audit;

Practice Aids to help auditors complete steps or processes outlined in the Knowledge-Based Audit documents and Audit
Programs;

Auditor’s Reports that provide a variety of sample auditor’s opinions on audited financial statements and the accompanying
internal control and compliance reports required by GAGAS, the OMB Compliance Supplement and the Uniform Guidance;

Correspondence documents that provide sample letters to be used to comply with GAAS requirements and in many other
common situations.

The AICPA’s Auditing Standards Board'’s (ASB) Risk Assessment Standards and AU-C Section 935, Compliance Audits, as applied
to the conduct of a single audit pursuant to the requirements of OMB Circular A-133 and the Uniform Guidance, are supported
with practice aids and tools to make the most of the latest technology to address audit requirements and the processes auditors
will need to implement in auditing compliance over federal awards pursuant to OMB Circular A-133 and the Uniform Guidance.
The knowledge-based audit (KBA) methodology will assist auditors of single audits by:



e Facilitating compliance with GAAS and GAGAS, the OMB Compliance Supplement and the Uniform Guidance;
e Encouraging more effective audits through tailored audit programs and comprehensive practice aids;

e Helping auditors to focus on and respond to identified audit risks; and

e Enhancing audit documentation.

ProSystem fx® Knowledge Coach

¢

ProSystem fx® Knowledge Coach functionality allows auditors/accountants to use the Knowledge-Based-Audit methodology
more efficiently by eliminating the need for duplicate entry of the same information, tailoring audit documentation to each
particular engagement, and documenting the link between risks identified and procedures performed. AUD-100S Tailoring
Question Workpaper is a document in Knowledge Coach that presents engagement-level questions designed to aid in tailoring
the engagement documentation to fit each client. Completing the questions helps the auditor avoid duplication and
unnecessary workpapers.

Before you begin your audit, please review the guidance in AUD-101S Overall Audit Program: Uniform Guidance Audit of Federal
Awards. This workpaper is intended to be your road map through a Knowledge-Based Audit methodology. You should start your
audit with AUD-100S Tailoring Question Workpaper and AUD-101S Overall Audit Program: Uniform Guidance Audit of Federal
Awards.

Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-502S
Summary of Assessments of Risks of Noncompliance. This allows the user to continuously assess risks during the engagement.
Several workpapers prompt the consideration of the presence of risks, but the Risk Summary task pane must be used to
document those risks. All documented risks flow to the Risk Summary. To ensure risks show in findings tables, make sure to
check the “workpaper identified in” field of the Risk pane.

Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the audit file.

Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.

Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes audit content, you can link
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference to
the accounting standards under the FASB and GASB Accounting Standards Codifications and the auditing standards issued by
the AICPA and the U.S. Government Accountability Office (GAO). Also, if you subscribe to the Knowledge-Based Single Audit
Guide on ARM, you can take advantage of links to the audit guide material from within the Knowledge Coach documents.

Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane.
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more
effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH'’s Accounting
Research Manager and industry audit guides by simply clicking on the Reference.



Download 2016 Knowledge-Based Single Audit(11/17/2016)

Description:
. Engagement v. 7.5 with Knowledge Coach 2.5 or higher and
Version: .
2016 Compliance Base
Release Date: November 2016
File size: 18MB

Approx. Download 42 minutes at 56 kbps

Time:

License: Full Version

Platforms: Windows® 7, 8, 8.1, 10

Office: Microsoft® Office 2010 or higher required

Contact Information

¢ For ademo or to purchase additional titles as they become available ~1-800-PFX-9998

¢ Technical Support 1-800-PFX-9998

The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this product. For
information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com.



